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This manual and the program it describes are
protected by the copyright laws and therefore may not
be reproduced (except to make a backup copy), in
whole or in part, whether for sale or not, without
written consent from Ad Lib Inc. Under the copyright
laws, copying includes translation into another
language or format.

The purchaser may use the program on any computer
in his or her posession, but on only one computer at a
time. It is possible, however, to purchase a multi-user
licence authorizing the purchaser to use the program
on several computers in his or her posession,
including a shared disk system.
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Music Synthesizer Card, Ad Lib Instrument Maker and
Ad Lib Visual Composer are trademarks of Ad Lib Inc.
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Enhanced Graphics Adapter are registered
trademarks of International Business Machines

Corporation.
PC/MS-DOS 2.00 and Microsoft are registered
trademarks of Microsoft Corporation.
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Corp.
Mouse Systems is a trademark of Mouse Systems
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Ad Lib Inc. is firmly committed to providing the highest
level of customer service and product support. If you
experience any difficulties when using our product, or
If it fails to operate as described, we suggest you first
consult the User Guide, and then, if you are still in
need of assistance, contact your dealer or call our
Technical Support Department:
Tel.: (418) 529-6252.

Notice

Ad Lib Inc. reserves the right to make changes or
improvements in the product described in this manual
at any time and without notice.

Limited Warranty

Ad Lib Inc. warrants the products that it manufactures
to be free of any defects in materials and
workmanship for a period of ninety (90) days from the
date of purchase. This warranty is limited to the
original purchaser of the product and is not
transferable.

Ad Lib Inc. will refund, repair or replace, at its option,
any media or documentation at no additional charge, if
found defective. The purchaser is responsible for
returning the product, and must provide a dated proof-
of-purchase.

Each program is sold "as is", and Ad Lib Inc. will not
be held responsible in any way whatsoever for direct
or indirect damages of any nature resulting from the
use of the program.

The purchaser has, however, the right to the legal
warranty when and to the extent that it is applicable,
notwithstanding any limitation or exclusion.
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Introduction

This guide describes and explains Instrument Maker, a
program with which you can create new instrumental sounds
for your Ad Lib Music Synthesizer Card. These sounds will be
of particular use with Visual Composer, where you can arrange
them in various ways to create your own compositions.

The first section, entitled "Getting Started", tells you everything
you should know before using the program.

The second section, "Description of the Synthesizer", briefly
explains the theory behind the two synthesis methods used
with the Ad Lib Music Synthesizer Card, and the role of
parameters in the creation of a sound.

The third section, "Using Instrument Maker", explains the way
to use the program and gives an example demonstrating how
to create the sound of a trumpet.

The fourth section, "References", reviews each of the
commands found in the menus.

Finally, in the appendices, you will find a list of preset sounds
provided with the program; an inventory of possible error
messages; and information pertinent to using a MIDI keyboard
and a mouse.

To take full advantage of the numerous possibilities offered by
Instrument Maker, we recommend that you carefully read this
guide and try out all the functions of the program.



Getting Started

This chapter lists the equipment required to run this program,
lists the contents of the diskette, shows you how to make a
startup diskette containing a copy of Instrument Maker, and
explains how to load the program.

Required Equipment

To run Instrument Maker, you need the following equipment:

1. The Ad Lib Music Synthesizer Card.

2. A computer:
IBM PC, PC XT, PC AT or a compatible equipped with at
least a 360K disk drive and having 256K of memory.

3. A graphic display card:
IBM Color Graphics Adapter (CGA) or IBM Enhanced
Graphics Adapter (EGA) display card.

4. An operating system:
PC/MS-DOS 2.00 or all latest versions.

5. Headphones, Speakers or Stereo System.

NOTE: You can also use Instalment Maker with a MIDI Interface and

with a mouse. Consult appendices 0 and D for details.



Getting Started

Contents of the Diskette

Contents of the Diskette

The instrument Maker diskette contains several files related to
the program:

•  AUTOEXEC.BAT

This file automatically loads Instrument Maker from the
moment your computer is turned on.

•  INSMAKER.BAT

This file contains the command sequence which loads
Instrument Maker from the DOS.

•  INSMAK1.EXE

This file contains the main part of Instrument Maker.
Never directly load this file. Instead, use the file
INSMAKER.BAT which contains the normal loading
sequence.

•  INSMAK1.RSR

This file contains the resources needed to run

Instrument Maker.

•  SOUND.COM

This file contains the sound driver of the Ad Lib Music
Synthesizer Card.

•  MPU401 .COM

This file contains the driver for the ROLAND MPU-401
MIDI interface.

•  MNS:

The ".INS" type files contain the instrumental sounds.

8



Getting Started

Contents of the Diskette

•  README.TXT

This file contains information concerning the latest
program updates, if there are any.

The SOUND.COM, INSMAK1.EXE and INSMAK1.RSR files
must always be in the current directory.

Before continuing, we suggest that you take a look at the
README.TXT file. To display this file:

1. Insert the diskette into drive A.

2. Type the following:

^  A>TYPE README.TXT

Making a Startup Diskette

Before using Instrument Maker, it is essential to make a copy.
Afterwards, put the original away in a safe place.

To begin operating, the computer needs a diskette containing
the DOS system files. You must therefore make such a
diskette, on which you will also place a copy of Instrument
Maker.

1. Insert a DOS diskette into drive A. This diskette must
contain the FORMAT program.



Getting Started

Making a Startup Diskette

(9ms

2. Execute the FORMAT program and specify the option
which will include a copy of the system files: ^

A>FORMAT A:/S ^

NOTE: Your DOS manual contains all the details conceming the
FORMAT command and the option IS.

(9m\

(m^

3. The FORMAT program will ask you to insert a blank
diskette into drive A.

4. When the operation is complete, insert the
Instrument Maker diskette into drive B. ^

5. Copy the contents of drive B onto the diskette in drive A:

A>COPY B:V/V ^
The diskette in the disk drive A is now a startup diskette ^
containing the Instrument Maker program.

NOTE: These instructions apply to a double disk drive system. If you
own a single disk drive system, the COPY program will ask
you to make the necessary diskette changes.

(fim\
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Getting Started

Loading the Program

Loading the Program

1. Insert the Instrument Maker startup diskette into drive A.

2. Turn on the computer (if the computer is already on,
simultaneously press the (^, and keys to
reset it).
instrument Maker will be automatically loaded.

OR, to load Instrument Maker without resetting.

Select drive A by typing:

A:

3. Load the program by typing:

A>INSMAKER

11



Description of the Synthesizer

This section provides a brief description of the basic principles
of sound synthesis and the different parameters which make up
a sound. This will give you a better understanding of the way
the synthesizer can produce a wide variety of sounds. This
information will also be useful in creating and modifying your
own sounds.

A Fundamental Part of the Synthesizer: the Operator

Like most synthesizers, the Ad Lib Synthesizer is made up of
oscillators and envelope generators. Here, an oscillator and a
generator are linked with a level controller to form what we call
an "operator". The operator is therefore a fundamental part of
the Ad Lib Music Synthesizer Card.

Oscillator
Envelope
Generator

Level

Controller
-H Output

Components of an Operator

0^
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Description of the Synthesizer

The Methods of Synthesis

The Methods of Synthesis

14

The Ad Lib Music Synthesizer Card generates sounds by
using one of the two following methods:

•  Frequency Modulation Synthesis

•  Additive Synthesis

In frequency modulation synthesis, the output of an operator is
used to modify the frequency of a second operator. The two
operators, therefore, have different functions: the one that
modifies is called a "Modulator" and the one that is modified, a
"Carrier". It is by this method of synthesis that two operators
can produce complex, resonant sounds.

Operator A/' /
—>

Operator N'2 —►
(Modulator) (Carrier)

Frequency Modulation Synthesis

In additive synthesis, the outputs of the two operators are
combined: one of these operators produces the fundamental of
the desired frequency; the other produces what we call a
"harmonic", which is an exact multiple of the fundamental. It is
the addition of these two outputs that produces the desired
sound.

fmms



Description of the Synthesizer

The Methods of Synthesis

Operator N^Z

Operator N" i

Additive Synthesis

The Ad Lib Music Synthesizer Card serves mainly to perform
frequency modulation synthesis. Additive synthesis, only
having two operators, is by far less efficient and produces
mostly "organ-like" sounds. Therefore, you will almost always
be using frequency modulation synthesis.

The Types of Sounds

The Ad Lib Music Synthesizer Card is composed of 18
operators which are grouped into pairs in order to produce
up to 9 melodic simultaneous sounds when used with Visual
Composer.

15



Description of the Synthesizer

The Types of Sounds

The synthesizer can also produce the following five percussion
instruments: Bass Drum, Snare Drum, Tom-Tom, Cymbal and
Hi-Hat. The sound of the Bass Drum requires 2 operators,
whereas the four others only need one. Consequently, when
using Visual Composer, you can obtain another assortment of
sounds:

6 melodic instruments (12 operators)

1 Bass Drum (2 operators)

1 Snare Drum (1 operator)

1 Tom-Tom (1 operator)

1 Cymbal (1 operator)

1 Hi-Hat (1 operator)

The Parameters

With Instrument Maker, the timbre of a sound is determined by
the parameters of the three components of the operators.
There are therefore three parameter categories:

Envelope generator parameters

Oscillator parameters

Level controller parameters /fP^
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Description of the Synthesizer

The Parameters

Envelope Generator Parameters

In the duration of a sound, the volume varies in accordance
with each instrument's distinctive curve. This curve is cailed the

"volume envelope", and it is by the Carrier operator that it can
be modified.

Furthermore, the timbre of most of the sounds changes from the
moment where the note is played to the moment where it
decays according to the instrument's distinctive curve. This
curve is called the "timbre envelope" and it is by the Modulator
operator that it can be modified.

The enveiope produced by an operator can be modified by
changing the value of the various parameters.

17



Description of the Synthesizer

The Parameters

Attack Rate

All envelopes start at level zero and work their way
towards a maximum level at a speed determined by the
Attack Rate. The envelope can reach the maximum
level instantaneously or after a short delay, depending
on the value given to this parameter.

Attack Decay

Sustain

Release

Maximum Level

Sustain Level

Zero Level

-Attack Rate

Decay Rate
Release Rate

An Envelope

Decay Rate
After having reached the maximum level, the envelope
moves towards the Sustain Level at a speed determined
by the Decay Rate.

18



Description of the Synthesizer

The Parameters

^  • Sustain Level
Once the envelope has reached the maximum level, it
immediately begins diminishing towards the Sustain
Level. The Sustain level can be either equal to or lower

^  than the maximum level depending on the value that
you have chosen for this parameter.

The envelope will remain on the Sustain Level only if
the Sustaining Sound is in effect; if it is not in effect, the
envelope will immediately start releasing and the sound

^  will be in that case a short one. (See the description of
«  the Sustaining Sound parameter below.)
0m,

^  • Release Rate
^  After having reached the sustain level, the envelope

starts heading towards level zero at a speed determined
by the Release Rate.

^  The envelope generator also enables the modification of the
^  two following parameters:

^  • Sustaining Sound
^  The Sustaining Sound parameter enables you to obtain
^  a sound which is kept at the Sustain Level tor as long as

the note is held. With this parameter, the sound release
m  occurs the moment the note is released.

^  • Envelope Scaling
With several musical instruments, the sound envelope
differs according to the pitch of the note. For example, a
high note on a piano is noticeably shorter than a low
note. Instrument Maker will automatically reproduce this
phenomenon when the Envelope Scaling is in effect.

^  19



Description of the Synthesizer

The Parameters

Oscillator Parameters

•  Frequency Multiplier ^
The Frequency Multiplier enables you to modify the ^
oscillator frequency so that the sound played becomes a
multiple of the depressed note's frequency. The
harmonics renders the sound more "intricate".

•  Pitch Vibrato

The Pitch Vibrato automatically brings about a slight
fluctuation to the oscillator frequency. ^

Modulation Feedback ^
The oscillator used in the modulator can itself be ^
modulated by feeding back the output signal into the
input. The Moduiation Feedback enables you to adjust
the modulation of this oscillator.

Level Controller Parameters

The following parameters deal with the overall output levels of
each operator.

Output Level
The Output Level enables you to adjust an operator's ^
maximal output level. When the two operators are used ^
in frequency modulation, the modulator output level ^
determines the modulation of the carrier; the carrier's ^
output level changes the overall volume of a sound.

20



Description of the Synthesizer

The Parameters

^  • Level Scaling
^  The sound level and timbre of acoustic instruments

varies according to the pitch of the note. For exampie,
the lower notes of a piano sound louder than the higher
notes. Level Scaling allows you to reproduce this
phenomenon: increasing the value given to this

^  parameter decreases the loudness of the higher notes.

•  Amplitude Vibrato
^  The Amplitude Vibrato automatically brings about a
^  slight fluctuation to an operator's output level.

21



Usinq Instrument Maker

The Screen Disp!a>

Instrument Maker's screen Is divided into three parts:

The menu bar at the top of the screen.

•  The parameter control panel in the center of the screen.

The piano keyboard at the bottom of the screen.

(S File (£) Options QQ Help

Decay Rate

Sustain Leuel

Release Rate

Sustaining Sound
Enuelope Scaling

Frequency Multiplier

Modulation Feedback

Pitch Uibrato

Output Leuel

Leuel Scaling
Rmplitude Uibrato

8  [T|

1  [M.
m

63

0  [H



Using Instrument Maker

The Menu Bar Commands

,5^

The Menu Bar Commands

Most of the Instrument Maker's commands are grouped by
menus according to category, so that they can be easily
located. The menu bar contains the titles of these menus.
The keys which open each menu are indicated at the left of
each title. At the right-hand side of the menu bar, the name of >
the opened file is indicated (when a new file is opened, the
name "Untitled" is seen here). ^

Opening and Closing Menus

1. Press the function key named to the left of the desired
menu.

The title becomes highlighted, and the menu containing the
commands is displayed on the screen. Commands that are
inaccessible at this time are dimmed. ^

2. Press the (He) key.
The menu closes.

(I"*"*
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Using Instrument Maker

The Menu Bar Commands

Untitled:!Options QQ Help

Saue fls... SEQ H

Sound File Directory...

Quit SEQ Q

Modulation Feedback

Pitch Uibrato

Output Leuel
Leuel Scaling

Rmplitude Uibrato

Choosing a Command from an Open Menu

1. Press one of the vertical arrow keys.((£j, |tj)-

Press the key which corresponds to the first letter of the
command.

The command you have chosen is highlighted.

NOTE: When more than one command begins with the same letter,
Visual Composer begins by highlighting the first one. If you
press the same key again, the next command starting with
this letter becomes highlighted.



Using Instrument Maker

The Menu Bar Commands

2. Press the EJ key.
Your choice is confirmed and the command you have chosen
is carried out.

Certain menu commands appear with a check mark beside
them to indicate that they are already activated.

Other menu commands are followed by an ellipsis (...). These
commands need additional information to be carried out.
When you choose one, a dialogue box appears on the screen.
You then enter the appropriate information and press the E)
key to confirm your instructions. If you wish to cancel these
instructions, press the (HD key.

Many of the menu commands can also be carried out by
shortcuts- a key sequence on the keyboard. Open the different
menus to see these key sequences; they are shown to the
right of the commands.

The Parameter Control Panel

The control panel occupies the major portion of the screen.
In this panel there are two columns of slide controls and
check boxes which are used to adjust the parameter values
of the two operators. The creation of a sound originates from
these two operators, each having a certain number of
modifiable parameters.

To set a parameter, you must first of all activate the operator in
which this parameter is found, then activate the parameter
itself. The frame surrounding one or the other of these columns
indicates which of the two operators is active; an indicator
highlights the name of the active parameter.

26



Using Instrument Maker

^  The Parameter Control Panel

Activating an Operator

^  • Press either the (iO or (iO key.
The name of the operator Is highlighted; the slide controls
and check boxes under this name are surrounded by a
frame.

Activating a Parameter

•  Press one of the vertical arrow keys to choose a
parameter.

/w, The chosen parameter is highlighted.

Modifying the Vaiue of a Parameter

Certain parameters can only have two values; they are
represented by a check box. When the parameter is in effect, a
cross will be seen in this check box; when the parameter is not
in effect, this check box will be empty. To operate these types
of parameters, press the space bar on the keyboard.

There are 2 types of parameters.

Other parameters can have several different values; they are
represented by slide controls. The value which you give to this

^  type of parameter is indicated by a number situated on the
«  right-hand side of each slide control. To modify these

parameters, press one of the horizontal arrow keys on the
keyboard; the value increases or decreases by one unit
depending on whether you press the right or left arrow key.

27



Using Instrument Maker

The Parameter Control Panel

To increase or decrease the value by several units at a time,
press and hold down the key, then press one of the
horizontal arrow keys.

The Piano Keyboard

The piano keyboard shows 60 of the 96 notes that the
synthesizer can play. This keyboard lets you hear the sound
you are creating and Is represented by certain keys on the
computer keyboard.

The symbol • which Is placed on one of the keyboard notes,
shows the position of "middle C" on the piano. The symbol "z",
corresponding Initially to middle C, represents the note which
Is played when you press the z key on the computer keyboard.
You will hear the other notes of this same octave by pressing
the following keys on the computer keyboard.

0# D# F# G# A#

dJ [£.
(D (X] O

(6] (H] (jj
V 1 dJ (□ (HJ

D B

1#^

28



Using Instrument Maker

The Piano Keyboard

^  To gain access tc the ether octaves, use the commands
^  "Transpose Keyboard Down" and "Transpose Keyboard Up" In
^  the Options menu. The position of the "z" symbol will change
^  accordingly.

When you press a key to hear a sound, the duration of this
sound is determined arbitrarily. If you hold the key down
before pressing one of the note keys, the sound is held for as
long as these keys are held down.

Creating a Sound: A Step-By-Step Example

In this section you will see, step by step, how to create the
sound of a trumpet. It is a simple example that will help you to

^  understand the process of sound creation with Instrument
Maker.

Loading the Program

1. Insert the program diskette into drive A.

2. Type "INSMAKER", then press the (3 key.
Instrument Maker is loaded and its parameter control panel
displays the parameter values corresponding to those of a
piano .

29



Using Instrument Maker

Creating a Sound: A Step-By-Step Example

Each time you open a new file with Instrument Maker, the
parameters for the sound of a piano always appear on the
screen. We are going to modify these parameters to gradually
transform the sound. By carefully following the example
described below, you will create the sound of a trumpet.
Before starting, listen to the piano sound already programmed.

Listening to the Sound

Press the (U key on the computer keyboard.
You hear a 0. The other notes of the scale can be

played with the keys on the bottom row, either E].
Q. (D. S. E] or ED onthe keyboard.

The sound of the piano that you hear is relatively short in
comparison to that of a trumpet. We are therefore going to
prolong this sound so that it resembles a little closer the sound
of a trumpet. As we saw earlier, it is the Sustaining Sound
parameter that modifies the duration of a sound.

Prolonging the Sound

1. Press the (iD key to choose the Carrier operator.

2. Press the O key until the Sustaining Sound parameter
is highlighted.

3. Press the space bar to put the Carrier's Sustaining
Sound parameter into effect.
A cross Is displayed In the check box to Indicate that this
parameter Is now In effect.

30



Using Instrument Maker

Creating a Sound: A Step-By-Step Example

4. Press the ̂  key to choose the Modulator operator.

^  5. Press the space bar to put the Modulator's Sustaining
^  Sound parameter into effect.

A cross is displayed in the check box to indicate that this
parameter is now in effect.

Listen to the result of this modification: the sound is now

prolonged. If you hold down the key and press the dD key,
the sound will be heard for as long as the key is held down.

The sound, however, is still far from being one of a trumpet.
^  First of all, you will notice that the volume of this new sound is

too low; we will turn up the volume by modifying the Carrier's
Sustain Level As we saw earlier, this operator is responsible
for the volume envelope.

Turning Up the Volume

1. Press the key to select the Carrier operator.

2. Press the IO key until the Sustain Levei is highlighted.

3. Press the Q key until the Sustain Levei reaches a
value of 12.

Listen to the effect of this modification: the volume is now
louder. However, you will notice that the timbre fluctuates for a
certain time before stabilizing. This phenomenon is caused by

«  a decay in the timbre envelope; the Sustain Levei of the
^  Modulator does not correspond to that of the Carrier we just

modified. Because the Modulator is responsible for the timbre
we will eliminate this fluctuation in the timbre by placing the
Modulator's Sustain Levei at it's maximum value.

31



Using Instrument Maker

Creating a Sound: A Step-By-Step Example

Removing Timbre Fluctuation

1. Press the ED key to select the Modulator operator.

2. Press the Q key until the Sustain Level is at its
maximum value (15).

Listen to the effect of this modification: the sound fluctuation

has disappeared. You now hear a steady sound.

A note played on a trumpet has a distinctive effect at the time of
the attack. We will try to recreate this effect by adjusting the
Attack Rate of both operators.

Modifying Sound Attack

1. Press the ED key to select the Modulator operator.

2. Press the O key until the Attack Rate parameter is
highlighted.

3. Press the Q key until the value given to this parameter
is 4.

4. Press the ED key to select the Carrier operator.

5. Press the Q key until the value given to this parameter
is 7.

Listen to the effect of this modification: the sound that you now
hear has many of the characteristics of a trumpet. However,
the timbre isn't rich enough. Enrich it by modifying the value of
the Modulation Feedback.

32



Using Instrument Maker

Creating a Sound: A Step-By-Step Example

^  Enriching the Sound

1. Press the (£0 key to select the Modulator operator.

^  2. Press the Q key until the Modulation Feedback Is
^  highlighted.

3. Press the Q key until the value given to the Modulation
^  Feedback is 6.

^  Listen to the effect of this modification: the sound is now much
^  "richer" and "ampler". However, when you play two notes very

close together, the attack of the second note is much weaker.
This is because the sound release is too slow.

Standardizing the Attack

1. Press the (iD key to select the Carrier operator.

2. Press the (D key until the Reiease Rate parameter is
highlighted.

3. Press the Q key until the Reiease Rate attains its
maximum value (15).

4. Press the (iD key to select the Modulator operator.

5. Press the Q key until the Reiease Rate attains its
maximum value.

Listen to the effect of this modification: the attack is uniform
whether you play a single note or several in succession. The
sound is now rich enough for a trumpet.
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Using Instrument Maker

Creating a Sound: A Step-By-Step Example

With a real trumpet, a sound differs according to its pitch. We ^
will listen to the sound an octave lower to see if it still ^
resembles the sound of a trumpet. ^

Listening to a Sound an Octave Lower ^

1. Press the (rD key.
The Options menu opens.

2. Press the O until the command Transpose Keyboard ^
Down is highlighted. ^

3. Press the [3 to confirm your choice.
The symbol z on the piano keyboard has moved to the left of
the • symbol to indicate that the ID is now playing an octave
lower than middle "0".

NOTE: You can try the sound at higher octaves by using
the command Transpose Keyboard Up.

If ypu listen to the sound at different octaves, you will notice that
it sounds better in some places than others. We will therefore
"scale" the sound so that it reproduces the effect of a real
instrument as it changes registers.

/MS

fMS
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Usinq Instrument Maker

Crealinq a Sound: A Step-By-Step Example

Scaling the Sound for all Registers

1. Press the (rij key to select the Carrier operator.

2. Press the a until the Envelope Scaling parameter is
highlighted.

3. Press the space bar to turn the Envelope Scaling off.

4. Press the dD to select the Modulator operator.

5. Press the space bar to turn the Envelope Scaling on.

If you have followed the instructions step by step, your
parameter control panel should display the following
parameter values:

Rttack Rate

Decay Rate

Sustain Leuel

Release Rate j
Sustaining Sound

Frequency Multiplier |
Modulation Feedback

Pitch Uibrato

Output Leuel {
Leuel Scaling {
Amplitude Uibrato

01 Carrier

Untitled i

(B Modulator

■  laO
■  laM

mtana



Using Instrument Maker

Creating a Sound: A Step-By-Step Example

Listen once again to the sound at different octaves: it now
reacts exactly like a wind instrument. Between the high and
low notes, there is a difference in timbre but not in volume. All
these parameter modifications have transformed the "piano
sound" into a "trumpet sound".

You now know how to program a sound with Instrument Maker.
The best way to go about creating a sound of your own would
be to pick a preset sound which resembles it the most, and
then modify it to your own liking. Before going any further, it
would be advisable to save the sound of the trumpet you just
created so as not to risk loosing it.

Saving the New Sound

1. Press the (ID key.
The File menu opens.

2. Press the Q key until the Save command is ^
highlighted. ^

3. Press the E] key to confirm your choice.
A dialogue box appears and asks you under what name you
would like to save this sound. The name you choose will
become the title of the opened file. m
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Using Instrument Maker

Creating a Sound: A Step-By-Step Example

4. Type the name of the instrument, for example,
"MYSOUND".

This name will be written in the dialogue box.

NOTE: Not all characters are accessible for use in a file title. If you
happen to use an unauthorized character, a warning signal
will let you know. On page 44, you will see which characters
are available when choosing a name.

5. Press the (3 key to confirm the command.
Your sound is now saved as a file, the name of which appears
on the right-hand side of the menu bar.

Continue to modify the values given to the different parameters
and listen to the produced effects. When you open a different
file. Instrument Maker will close the one you're working on and
ask you if you desire to save the most recent modifications.
You can, at anytime, find this file inside the directory where it
was saved by using the Open command.

Getting Back to a File

1. Press the (iD key.
The file menu opens.

2. Press the O key until the Open command is
highlighted.
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Using Instrument Maker

Creating a Sound: A Step-By-Step Example

3. Press the Q key to confirm your choice.
A list of the files stored in the directory appears on the
screen.

4. Press the Q key until the name of the desired file is
highlighted.

5. Press the E] key to confirm your selection.
The parameter control panel displays the values corresponding to
the sound stored in this file. The name of this file appears on the
right-hand side of the menu bar.

Take the time to explore the effects of different parameter
values, create new instrumental sounds and save them ready
to be used in your musical compositions with Visual Composer.

Using a New Sound with Visual Composer

Visual Composer is provided with a directory of sounds which
is already quite large. But it would be also useful to integrate
the sounds that you have created with Instrument Maker into
your compositions. Here is how to introduce a copy of these
sounds into Visual Composer.

NOTE: Consult Appendix A (page 49) to see the list and description ^
of the sounds included with the program.
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Creating a Sound: A Step-By-Step Example

1. Quit instrument Maker by using the command Quit
in the File menu.

2. Make sure that the Instrument Maker diskette is in
drive A.

3. Insert the Visual Composer diskette into drive B.

4. Type the following message in the DOS to copy an
instrument named "MYSOUND" onto the Visual
Composer diskette, in drive B.

A>COPY MYSOUND.INS B:

Now that you have changed the sound of a piano to the sound
of a trumpet, you are familiar with the procedure of sound
creation with Instrument Maker,
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This section describes one by one the commands found in the
^  menus.

^  The menu bar dispiays the titles of the different menus
^  provided by Instrument Maker: File, Options, Help. To open

any of these menus, all you have to do is press the appropriate
function key. You can close a menu by using the key.

The File Menu

New

The Fiie menu contains all the commands relating to files. To
open this menu, press the (£0 key. The menu listing ail its
commands is then displayed on the screen.

When creating a new sound, it is best to work starting from a
sound already programmed. The command New opens an
untitled file which aiready contains the parameters for a
piano; the chosen synthesis process is Frequency
Moduiation. Starting from this sound, you can program a new
sound. When you choose New, the open file displayed on
the screen is closed to make room for the new one.
Instrument Maker takes the precaution, however, of first
asking you if you wish to save the latest changes made.
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The File Menu

Open...

This command opens a file in the active directory. When you
choose the command Open, a dialogue box appears on the
screen listing all the Instrument Maker files in this directory.

IFSiam Q) Options BQ Help

Decay Rate

Sustain Leuel

Release Rate

Sustaining Sound
Enuelope Scaling

Untitled :

Frequency Multiplier
Modulation FeedbacI

Pitch Uibrato

Output Leuel

Leuel Scaling

Rmplitude Uibrato

Sound File Directory:

c:\rolldemo

IS Modulator

banjo2
bassi

bassE

bassoon 1

bassoonE

Select Sound:

I  (B§ Cancel""!

To choose a file from this list, press the vertical arrow keys (O
or (D ). When the indicator comes to the desired file, press the
E] key to confirm your choice. If the list has too many file
names to fit in the dialogue box, you can scroll to the file of your
choice using the Q or Q key.
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The File Menu

You can also press the alphabetic key corresponding to the
first letter of the file name: the indicator will move right to it.
If there is more than one command which starts with the

same letter, press the Q key.

When you choose Open..., the open file displayed on the
^  screen is closed to make room for the new one; Instrument
^■1^ Maker takes the precaution, however, of first asking you if you
^  wish to save the latest changes made.

^  Save

This command saves the open file in the current directory. If
^  this file has already been named, it will be saved automatically.

If, however, it is a new file, a dialogue box will appear so that
«  you can name this file.

Save As.

NOTE: Refer to the following paragraph (Save As. . .) for the rules
which apply to naming of fiies.

The Save As... command is used to save the open file under a
new name. If the name you choose has already been used for
an existing file in the current directory, a dialogue box asks you
if you wish to replace the old one.
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The File Menu

When choosing a name for a file, you must adhere to the
following rules:

the name must have from 1 to 8 characters:
these characters are to be chosen from the capital and
small letters of the alphabet and from the digits 0 to 9;
letters and numbers can be combined.

Revert

This command cancels the modifications you are making to a
file. It reverts the file back to what It was the last time you
saved.

When you ask Instrument Maker to revert a file It will always
ask you for a confirmation of this command.

Instrument File Directory...

This command links the program to a new Instrument file
directory. This makes It possible to use and save sounds In a
different directory than the one to which the program was first
linked. Enter the name of the directory desired In the dialogue
box which appears, abiding by the DOS conventions. Finally,
press the ED key to confirm your choice. From now on, the file
list which appears with the command Open contains the files
belonging to this new directory.

44



References

The File Menu

^  In other words, a directory name takes the following form:

<Drlve:> \ <Directory name> Q
1*^

Example: to gain access to a sound file placed in the directory
named SOUND in drive B, type:

B:\SOUND Q

If you wish to have more details concerning the DOS
conventions, consult your DOS manual.

_  Quit

^  This command is used to end an Instrument Maker session and
^  return to DOS. If you have made changes since last saving the
^  file, a dialogue box appears and gives you the opportunity to
^  save these changes before quitting.

'-N The Options Menu

To open this menu, press the (il) key: the list of commands
contained in this menu appears on the screen.

^  Transpose Keyboard Up

inm,

This command makes the computer keyboard play an octave
higher.
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The Options Menu

Transpose Keyboard Down

This command makes the computer keyboard play an octave
lower.

Additive Synthesis

The command Additive Synthesis enables you to change the
synthesis process being used. If the name of this command is
checked off in the menu, additive synthesis is in effect. If it is
not checked off, Frequency Modulation Synthesis is in effect.

Melodic Mode

This command puts Instrument Maker into Melodic Mode which
enables you to create sounds to be used in any of Visual
Composer's melodic voices.

Bass Drum Mode

This command puts Instrument Maker into Bass Drum Mode
which enables you to create sounds to be used in the Bass
Drum voice (BD) of Ad Lib Visual Composer.

Snare Drum Mode

This command puts Instrument Maker into Snare Drum Mode
which enables you to create sounds to be used in the Snare
Drum voice (SD) of Ad Lib Visual Composer.

Tom-Tom Mode

This command puts Instrument Maker into Tom-Tom Mode
which enables you to create sounds to be used in the Tom-
Tom voice (TO) of Ad Lib Visual Composer.
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The Options Menu

Cymbal Mode

^  This command puts Instument Maker into Cymbal Mode which
enables you to create sounds to be used in the Cymbal voice

^  (CY) of Ad Lib Visual Composer.

^  Hi-Hat Mode
-f-in This command puts Instrument Maker into Hi-Hat Mode which

enables you to create sounds to be used in the Hi-Hat voice
^  (HH) of Ad Lib Visual Composer.

^  MIDI Input

This command becomes accessible when Instrument Maker

detects the presence of a MIDI driver (see Appendix C, page
^  59). When you choose this command, it appears with a check

mark beside it; from then on, all notes played on the MIDI
keyboard are heard through Instrument Maker and the Ad Lib
Synthesizer Card. The MIDI input command is activated and

^  de-activated alternately by choosing it.
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The Help Menu

The Help Menu

The Help menu gives you access to a summarized program
guide.

When you press the (ri^ key, a list of topics appears on the
screen. When you choose one of them, a window containing
information pertinent to this topic opens.

The arrows located at the bottom of this window indicate which

keys are used to see the other pages of this document. To
close this window, press the Escape key.

File (£] Options IFIOI

IS Modulator

cay Rate

stain Le

lease Rf

staining
uelope I

tput Lei
Leuel Seal

Rmplitude

The fld Lib Music Synthesizer Card can produce 96 notes in 8
octaues.

The piano keyboard displayed on the bottom of the screen
represents 60 of these notes.

The • symbol represents the middle C of the piano keyboard.
The O symbol represents the note mhich mill be played mhen
you press the "z" key on the computer keyboard. The other
keys of the bottom rom play the other notes of the scale.

Btl Cancel



Appendix A
List of Preset Sounds

ACCORDN

BANJ01

BASS1

BASS2

BASSOON1

BDRUM1

BELLS

BRASS1

CBASSOON

Accordion: rich, clear tone. Best register: from one octave
below to four octaves above middle C.

Banjo: excellent for short notes in quick succession; sounds
best from one octave lower to three octaves higher than
middle C.

Double bass: weak volume; inaudible when notes are very
low. Best register: the two octaves below middle C.

Electric bass: smooth; best when used in second and third
octaves below middle C.

Bassoon: sounds an octave lower than written. Best register:
from one and a third octaves below to two octaves above

middle C.

Bass drum: hammering; sounds best in the second octave
below middle C.

Chiming bells: brilliant and resonnant; sound best between
the first octave below to the three octaves above middle 0.

Brass ensemble: "brassy"; sounds best from two octaves
below to two octaves above middle 0.

Contrabassoon: deep, grand-sounding tone; sounds an
octave lower than written; cannot be played quickly. Best
register: two and a half octaves below middle 0.
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CELESTA Celesta: instrument made with small metal plates; delicate
sound like a music box; sounds two octaves higher than
written. Best register: from two octaves below to two octaves
above middle C.

CLAR1 Clarinet: best when used one octave below and two to three
octaves above middle C.

CLAR2 Bass clarinet: slow attack; sounds an octave lower than
written. Best register: one octave lower and two octaves
higher than middle C.

CROMORNE Cromorne: wind instrument used in Renaissance Period; very
accentuated reedy sound. Best register: from one octave
below to two octaves above middle C.

CYMBAL1 Cymbal: medium-crash (high pitched), played with drumstick.

ELCLAV1 Electric keyboard: clear penetrating tone; sounds best from
two octaves below to two octaves above middle C.

ELGUIT1 Electric rock guitar: distorted (fuzz pedal effect). Best register:
from one octave below to two octaves above middle C.

ELGUIT2 Electric jazz guitar: soft; slightly metallic; sounds best from
two octaves below to three octaves above middle C.

ELGUIT3 Electric guitar: complex timbre, similar to an intermodulation
effect; sounds an octave higher than written. Best register:
from two and a half octaves below to two octaves above
middle C.

ELPIAN01 Piano: like a standard electric piano; short release; excellent
in quick passages; sounds best between three octaves below
and four octaves above middle C.
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List of Preset Sounds

ELPIAN02

FLUTE

FLUTE1

FLUTE2

HARPSI 1

HARPSI 2

HARPSI 3

HIHAT1

H1HAT2

JAVAICAN

JEWSHARP

Piano: "brassy" electric piano; sustained sound; sounds an
octave higher than written. Best register: from the four
octaves below to the four octaves above middle C.

Flute: soft sound; additive synthesis; sounds best in the four
octaves above middle C.

Flute: soft muffled sound; sounds best in the four octaves
above middle C.

Flute: like flute sound on an electric organ; sounds best in the
four octaves above middle C.

Harpsichord: deiicate twangy sound; sounds an octave
higher than written. Best register: from three octaves below to
three octaves above middle C.

Harpsichord: full accentuated sound; sounds best from two
octaves below to two octaves above middle C.

Harpsichord: appropriate timbre for low register; sounds best
in the three octaves beiow middle C.

Hi-Hat: closed double cymbals played with drumstick;
metallic resonant sound.

Hi-hat: closed double cymbals played with drumstick; short
yet soft sound.

Sounds like oriental string/percussion instrument; siightiy
indistinct attack. Best register: from one octave below to two
octaves above middle C.

Jews' harp: produces a funny twangy sound. Use in the first
octave above middle C.
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LASER

L0GDRUM1

MARIMBA1

MARIMBA2

0B0E1

ORGAN 1

0RGAN2

ORGANS

PIAN01

PIAN02

Electronic sound effect: mysterious, complex sound; evokes
feeling of futuristic science fiction; should only be used in
Cymbal Mode. (The sound and pitch do not change
according to the note or the register.)

African percussion instrument; dry yet hollow sound. Best
register: from one octave below to four octaves above
middle 0.

Marimba: wooden bars played with medium-hard mallets;
sounds best from one octave below to four octaves above
middle 0.

Marimba: wooden bars played with hard mallets; resonant
and slightly metallic. Best register: same as Marimbal.

Oboe: sounds best in the two and a half octaves above
middle 0.

Electric organ: bright sound; sounds best from one and a half
octaves below to three octaves above middle 0.

Electric organ: velvety; additive synthesis; sounds best from
two octaves below to two octaves above middle 0.

Organ: standard electric organ sound. Best register: from
three octaves below to four octaves above middle 0.

Piano: sounds best from three octaves below to four octaves
above middle 0.

Resonant piano: pedal effect; sustained; same register as
Piand. (Everything played lower than the first octave below
middle 0 sounds like a resonant electric bass.)
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SAX1

SITAR1

SNAKEFL

SNARE1

SYN1

SYN2

SYN3

SYN4

SYN5

Saxophone: sounds best from two octaves below to two
octaves above middle C.

Indian Sitar: rich and resonant; sounds best from one octave
below to two and a half octaves above middle C.

"Snake Flute": timbre of an oriental reed instrument; piercing
twangy sound; reminds one of snake charmers. Best register:
from one half to one octave below to three octaves above

middle C.

Snare drum: snappy; high pitched.

Synthesizer: slow attack; sonorous. Best register: the three
octaves either side of middle C.

Synthesizer: short, staccato, artificial sound of plucked
strings; sounds best from two octaves below to four octaves
above middle C.

Synthesizer: resonant; short attack. Best register: from three
octaves below to four octaves above middle C. (When used
in the second and third octaves below middle C, a rich and
powerful bass sound is produced.)

Synthesizer: twangy brass sound; sounds best in the two
octaves below and four octaves above middle C.

Synthesizer: very piercing sound; lots of high harmonics.
Best register: from two octaves below to two octaves above
middle C.
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SYN9

SYNBASS1

SYNBASS2

SYNBASS4

TINCAN1

T0M1

T0M2

TR0MB1

TR0MB2

TRUMPET1

TRUMPET2

Synthesizer: metallic sound like the stroke of a bell-clock;
small, "bathtub"-like resonance; sounds best in the three
octaves below and first one and a half octaves above

middle C.

Synthesizer: buzzing distorted bass; sounds an octave lower
than written. Best register: the two octaves below middle C.
(Also interesting above middle C.)

Synthesizer: "wasp" sound (weird); slow attack; sounds best
when used from the two octaves below to one octave above

middle C.

Synthesizer: buzzing sound, as of insects; rather short and
aspirated sound. Best register: from the two octaves below to
the two octaves above middle C.

Percussion effect: dry, metallic sounds, varying from note to
note; indeterminate pitch; use above middle C.

Tom-tom: smooth; sounds best the third octave and half of the
fourth octave below middle C.

Tom-tom: muffled, reminding one of real skin drums, such as
congas. Best register: the two octaves below middle C.

Trombone: "brassy"; sounds best when used from the two
octaves below to one octave above middle C.

Trombone: velvety; same register as Trombi.

Trumpet: very sonorous (striking); sounds best from one
octave below to three octaves above middle C.

Trumpet: soft; slow attack (wah-wah mute effect); same
register as Trumpetl.
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TRUMPETS

TRUMPET4

TUBA1

VIBRA1

VI0LIN1

VI0LIN2

VLNPIZZ1

WAVE

XYL01

XYL02

Trumpet: very resonant: twangy; excellent for quick passages;
same register as Trumpet!.

Trumpet: smooth; same register as Trumpet!.

Tuba: with characteristic slow attack; sounds best when used
in the two and a half octaves below middle C.

Vibraphone: metal bars played with medium mallets; vibrato;
sounds an octave lower than written. Best register: four
octaves above middle C.

Violin: strings played with bow; rich sound; best when used in
the four octaves above middle C.

Electric violin: noisy sonority, with light vibrato; same register
as Violin!.

Violin: strings played pizzicato (very short plucked sound);
volume weak. Best register: from one octave below to three
octaves above middle C.

Unusual instrument: ethereal, flute-like sound; long smooth
attack; sounds two octaves higher than written; sounds best
when played from the three octaves below to the three
octaves above middle C.

Xylophone: narrow wooden bars played with medium
mallets; sound very dry and dampened. Best register: the
second, third and fourth octaves above middle C.

Xylophone: narrow wooden bars played with medium-hard
mallets; sound very dry and dampened; brighter sound than
Xylo!. Best register: the four octaves above middle C.
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Directory "XXX" not found.
There is no directory corresponding to this name. Make
sure that the name conforms with the DOS convention.

Disk drive is not ready, re-insert diskette, close
door and try again.
The program cannot gain access to the disk drive. Make
sure that the diskette is properly inserted into the disk
drive and that the door is closed, then try again.

Diskette is write-protected, remove protection
and try again.
No information can be added to the diskette because it
is write-protected. Remove the protection and try again.

Error while reading or writing, diskette may be
unusable.

The program cannot gain access to the contents of the
diskette. By using the COPY command in the DOS,
copy the contents of the diskette onto a blank diskette
and try again.

Error while writing file, insufficient disk space.
There isn't enough space on the diskette to write the
data. This message could also appear if the maximal
number of files on a diskette is attained.
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File "XXX" not found.

The program cannot find the specified file. This is
probably because the music file diskette was removed
after the OPEN command had been executed. To
correct, re-insert the music file diskette. ^

Resource file not found. ^
The program cannot function because the file
INSMAK1 .RSR is not in the current directory.

Sound driver is not installed.

The program cannot function because the sound driver
has not been loaded. Load the sound driver and try
again. (This should not happen if you use the normal ^
loading procedure.) _
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Using a MIDI Keyboard

If your computer is equipped with a Roland DG MIDI
Processing Unit MPU-401, or any compatible, you may use a
MIDI keyboard to hear the sounds of the Ad Lib Synthesizer
Card.

In order to do so, simply load the MIDI driver provided on the
diskette into memory by writing the following command at the
DOS prompt:

A>MPU401

When the MIDI Input command from the Options menu is
activated (see page 47), the connected MIDI keyboard serves
to play the sound you are making with Instrument Maker.

When Instrument Maker is put into the Melodic Mode of sound
editing, up to nine sounds can be played simultaneously on the
keyboard. When Instrument Maker is put into one of the
percussion modes of sound editing, only one sound can be
played on the keyboard at a time.
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Using a Mouse

This appendix explains how to use Instrument Maker with a
mouse - which we take for granted you know how to operate.

Loading Instrument Maker

When you wish to use your mouse.

Instrument Maker automatically detects and utilizes a mouse
driver if one is loaded. Load your mouse driver according to
the manual that comes with the mouse. Next, load Instrument
Maker in the usual fashion. The program is compatible with
mouses by Microsoft (and all related drivers) and Mouse
Systems PC Mouse.
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Using a Mouse

NOTE: You may integrate the loading of the mouse driver with the
AUTOEXEC.BAT file. «

•  When you DON'T wish to use your mouse.

Load the program with the option 7-m". This option prevents
the automatic utilization of the mouse driver. At the DOS, type: ^

A>INSMAKER /-M «

The Distinctive Characteristics -

The characteristics of Instrument Maker with a mouse occur in
the following 2 operations:

1. Choosing an element

2. Changing the value of the parameters

62

Choosing an eiement in a list

♦  A command in a menu ^
Position the pointer on the title of the menu desired. ^
Click and drag to the chosen command, then release ^
the mouse button.



Appendix D

Using a Mouse

' A file in a list

^  Click and drag to the name your choice, then release
the mouse button, if the list of files is too long for the
window, click on the arrow in the scroll bar to scroll
the list.

^  ' A button inside a window
Click the button of your choice. The action described on
the button will automatically be put into effect.

Changing the Vaiue of the Parameters

With a slide-control

Click on one of the horizontal arrow keys: the value of the
parameter will progressively go up or down. You may
also click on the grey zone of the slide-control, or drag the
"control knob" to change the value more rapidly.

With a check box

Click on the box corresponding to the parameter of your
choice: this parameter will either switch on or off; and,
depending on the case, a cross inside the box will either
appear or disappear.
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